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CHAPTER ONE
INTRODUCTION
1.1	HISTORY OF SIWES
SIWES (Student Industrial Working Experience Scheme) was established by ITF in 1973 to solve the problem of lack of adequate practical skills preparatory for employment in industries by Nigerian graduates of tertiary institutions.  
The Scheme exposes students to industry based skills necessary for a smooth transition from the classroom to the world of work. It affords students of tertiary institutions the opportunity of being familiarized and exposed to the needed experience in handling machinery and equipment which are usually not available in the educational institutions.  Participation in Industrial Training is a well-known educational strategy. Classroom studies are integrated with learning through hands-on work experiences in a field related to the student’s academic major and career goals. 
Successful internships foster an experiential learning process that not only promotes career preparation but provides opportunities for learners to develop skills necessary to become leaders in their chosen professions.  
One of the primary goals of the SIWES is to help students integrate leadership development into the experiential learning process. Students are expected to learn and develop basic non-profit leadership skills through a mentoring relationship with innovative non-profit leaders. 
By integrating leadership development activities into the Industrial Training experience, we hope to encourage students to actively engage in non-profit management as a professional career objective. However, the effectiveness of the SIWES experience will have varying outcomes based upon the individual student, the work assignment, and the supervisor/mentor requirements.
It is vital that each internship position description includes specific, written learning objectives to ensure leadership skill development is incorporated.
Participation in SIWES has become a necessary pre-condition for the award of Diploma and Degree certificates in specific disciplines in most institutions of higher learning in the country, in accordance with the education policy of government.

1.2 	OPERATORS OF SIWES
Operators - The ITF, the coordinating agencies (NUC, NCCE, NBTE), employers of labor and the institutions. 
Funding - The Federal Government of Nigeria 
Beneficiaries - Undergraduate students of the following: Agriculture, Engineering, Technology, Environmental, Science, Education, Medical Science and Pure and Applied Sciences.  
Duration - Four months for Polytechnics and Colleges of Education, and Six months for the Universities.
1.3 	OBJECTIVES OF SIWES
1.	SIWES will provide students the opportunity to test their interest in a particular career before permanent commitments are made. 
2.	SIWES students will develop skills in the application of theory to practical work situations. 
3.	SIWES will provide students the opportunity to test their aptitude for a particular career before permanent commitments are made. 
4.	SIWES students will develop skills and techniques directly applicable to their careers.
5.	SIWES will aid students in adjusting from college to full-time employment.

1.4	HISTORICAL BACKGROUND OF THE ORGANIZATION
360 Print Hub is a reputable printing and branding company located in Ilorin, Kwara State. It specializes in digital and offset printing, including branding on materials such as T-shirts, caps, banners, business cards, and promotional items. The company is known for delivering high-quality prints using advanced technology.. The ANBJ has several departments, some are printing and publishing department, Cinematography and Photography Studio Department, Computer Works Department which is the department I found interesting in my SIWES programme  
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1.6 Major Activities of the Organization
· Graphic design (using CorelDRAW, Photoshop, and Illustrator)
· Large format printing (banners, flex, and billboards)
· T-shirt and cap branding
· Heat press printing	
· Offset and digital printing
1.7 Section/Unit of the Organization and Their Specific Functions
· Design Unit – Handles the creation of graphic designs.
· Printing Unit – Oversees all printing activities.
· Production Unit – Handles material branding and finishing.
· Marketing & Customer Service Unit – Manages customer inquiries and orders.
 

CHAPTER TWO
MICROSOFT WORD
2.1 What is Microsoft Word?
Microsoft Word is a widely used word-processing software developed by Microsoft Corporation. It is part of the Microsoft Office Suite and is used for creating, formatting, editing, and printing documents. The software provides various tools for text editing, layout design, and collaboration, making it essential in both academic and professional environments.
Microsoft Word is particularly beneficial for businesses like 360 Print Hub, where document creation, invoice generation, report writing, and proposal development are necessary for daily operations. The software supports various file formats, including .doc, .docx, .pdf, and .rtf, ensuring compatibility with different platforms and applications.
2.2 How to Open Microsoft Word?
Opening Microsoft Word depends on the version installed and the operating system being used. Below are the general steps to open the application on a Windows computer:
1. Using the Start Menu:
· Click on the Start menu (Windows icon on the bottom left of the screen).
· Type "Microsoft Word" in the search bar.
· Click on the Microsoft Word application to launch it.
2. Using a Shortcut Icon:
· If there is a Word shortcut on the desktop, double-click on it.
3. Using the Run Command:
· Press Windows + R on the keyboard.
· Type "winword" and press Enter to launch the application.
4. Opening a Word Document Directly:
· Locate a saved .doc or .docx file on the computer.
· Double-click on the file to open it in Microsoft Word.
2.3 Understanding the Design and Daily Analysis in Microsoft Word
At 360 Print Hub, Microsoft Word is an essential tool for various business functions, including:
Document Formatting and Editing
· Text Formatting: Microsoft Word allows users to change font styles, sizes, and colors to enhance document presentation.
· Paragraph Formatting: Users can adjust line spacing, text alignment, and indentation for a structured document layout.
· Bullets and Numbering: Essential for listing items in an organized manner.
Designing Business Documents
· Invoice and Quotation Preparation: Microsoft Word is used to create invoices, quotations, and receipts for customers.
· Letterhead and Business Proposals: The organization designs official letters and proposals using customized templates in Word.
· Marketing Materials: Flyers and brochures with text-based content are formatted using Word before final printing.
Tables and Data Organization
· Microsoft Word provides table formatting tools that allow businesses to organize data efficiently.
· At 360 Print Hub, tables are used to keep track of orders, material lists, and pricing details.
Proofreading and Spell Checking
· Microsoft Word includes built-in spelling and grammar check tools, ensuring documents are error-free before printing.
2.4 Understanding the Printing Machine and How to Use It
After creating documents in Microsoft Word, the next step is printing. 360 Print Hub uses different printing machines depending on the type of document:
1. LaserJet Printers – Used for high-quality document printing, such as invoices, letterheads, and official correspondences.
2. Inkjet Printers – Suitable for printing color documents and simple marketing materials.
3. Digital Press Machines – Used for large-scale production of flyers, brochures, and certificates.
Printing Steps in Microsoft Word:
· Click on File > Print to access the print settings.
· Select the Printer Name from the list of available printers.
· Choose the number of copies and the paper size.
· Click Print to start the printing process.
2.5 How to Use a Heating Press Machine
A heat press machine is used to transfer printed designs from paper to fabric materials such as T-shirts, caps, and bags. At 360 Print Hub, Microsoft Word is often used to format and align text-based designs before printing them on transfer paper.
Steps in Using a Heat Press Machine:
1. Design and Print Preparation: 
· The text or logo is first created in Microsoft Word and printed using a sublimation printer.
2. Preheating the Heat Press: 
· Set the temperature and time according to the material being printed.
3. Placing the Design on the Material: 
· The printed transfer paper is positioned on the T-shirt or cap.
4. Pressing the Material: 
· The heat press machine applies pressure and heat for a few seconds.
5. Finalizing the Print: 
· After cooling, the transfer paper is removed, leaving the design permanently imprinted on the fabric.
Microsoft Word is an essential tool at 360 Print Hub, serving multiple purposes such as document creation, design formatting, and print preparation. The software enhances efficiency by streamlining business operations, ensuring that printed materials maintain professional quality. Additionally, Microsoft Word integrates seamlessly with printing and branding activities, making it an invaluable asset for the organization.
 

















CHAPTER THREE
POWERPOINT
3.1 How to Open a Computer and Use a Mouse to Open PowerPoint
Opening PowerPoint on a computer involves a few simple steps, whether you are using a Windows or Mac operating system. Here's a general guide on how to open and start using PowerPoint:
For Windows:
1. Click the Start Menu
· Click on the Start menu at the bottom-left corner of your screen (Windows logo).
2. Search for PowerPoint
· In the search bar, type "PowerPoint". The program should appear in the search results.
3. Select PowerPoint
· Click on Microsoft PowerPoint from the list to open it.
Alternatively, you can use a desktop shortcut to open PowerPoint directly if you have one on your screen.
For Mac:
1. Click on the Finder
· Click on the Finder icon (a smiling face) in the dock.
2. Search for PowerPoint
· In the search bar, type "PowerPoint" and press Enter.
3. Open the Application
· Click on the Microsoft PowerPoint icon to launch the program.
Once PowerPoint is open, you can begin creating your presentation by selecting Blank Presentation or a template that suits your needs.
3.2 Skills Acquired on Animation and Transition
PowerPoint offers a wide range of tools for adding animations and transitions, which are crucial for enhancing presentations and engaging the audience. Below are some skills acquired through working with animations and transitions:
Animations
Animations are visual effects applied to text, images, shapes, and other objects on slides. They are used to add movement and attract attention to key points. Some basic animation options include:
· Entrance Animations: These make objects appear on the slide. For example, the Fade In or Wipe animations.
· Emphasis Animations: Used to highlight an object that is already on the slide. For example, the Grow/Shrink or Spin animations.
· Exit Animations: Used to make an object disappear from the slide. For example, Fade Out or Disappear.
To add an animation:
1. Select the object you want to animate.
2. Click on the Animations tab in the top menu.
3. Choose an animation from the gallery.
4. You can also set the animation timing, such as whether it should start on click, after a previous animation, or with a previous animation.
Transitions
Transitions are effects that occur when moving from one slide to another. These effects help in making the presentation flow smoothly. Some basic transition effects include:
· Fade: A simple transition where one slide fades into the next.
· Push: A slide transitions by "pushing" the previous slide out of the screen.
· Zoom: The slide zooms in or out as it moves to the next slide.
To add a transition:
1. Select the slide you want to add a transition to.
2. Click on the Transitions tab in the top menu.
3. Choose a transition effect from the gallery.
4. Set the transition's duration and timing.
Both animations and transitions can be adjusted to match the style of your presentation and the message you want to convey.
3.3 Documenting Face Cap Customization
Face cap customization is one of the creative tasks that can be designed and documented using PowerPoint. This can involve showcasing designs, logos, and how the customization process works. At 360 Print Hub, PowerPoint is often used to display and explain the various designs for custom face caps.
Steps for Documenting Face Cap Customization:
1. Create a Slide: Start by creating a blank slide.
2. Insert Images: Use the Insert tab to add images of the face caps.
3. Add Text: Provide details about the customization process (such as colors, designs, and placement).
4. Insert Shapes: Use shapes to illustrate areas where logos or text will be printed on the cap.
5. Add Animations: Use animations to demonstrate how the design evolves on the cap, e.g., showing how the logo is added.
Example of a slide with face cap customization:
This allows customers or team members to visualize the process, making it easier to understand how their custom designs will look on the product.
3.4 Biro Customization
Customizing items like biros (pens) can be easily presented using PowerPoint, particularly when showcasing designs and branding options. The key skills involved in documenting biro customization include:
1. Using the Shapes Tool: You can draw or design a representation of the biro using PowerPoint’s Shapes tool (e.g., a simple rectangle for the body of the biro).
2. Adding Logos and Text: You can use the Insert Picture option to add logos or use the Text Box to add customer names or slogans to the biro.
3. Showcasing Colors: PowerPoint allows you to change the color of the biro's body and logo to reflect customer preferences.
Steps for Documenting Biro Customization:
· Step 1: Use the Shapes tool to create a basic representation of a biro.
· Step 2: Add logos or names on the pen's body by inserting text or images.
· Step 3: Experiment with different colors to match branding or customer requests.
· Step 4: Animate the transition from one biro design to another to show options.
Example of a slide with biro customization:
By using PowerPoint, a complete and detailed presentation of custom biro designs can be easily created for clients or for internal use in the design process.
3.5 Material Selection and Handling
In the production of customized items like face caps, biros, or other promotional materials, the selection of materials is crucial for ensuring quality and durability. PowerPoint can be used to document and display the different materials available for printing.
Steps for Material Selection in PowerPoint:
1. Insert Material Images: Display pictures of various materials such as cotton (for caps), plastic (for biros), and different fabrics (for T-shirts).
2. Provide Specifications: Include information about the materials such as durability, cost, and suitability for printing.
3. Demonstrate Material Handling: Use animation to show how different materials are handled during the production process. For instance, show how caps are arranged for printing or how pens are prepared for logo application.
Example of material selection slide:
This type of documentation helps the production team understand the specific materials they are working with, ensuring that the quality standards are met for each custom item.
Conclusion
PowerPoint is an invaluable tool in presenting, documenting, and explaining various aspects of the customization process at 360 Print Hub, from face cap and biro customization to the selection and handling of materials. By utilizing animations, transitions, and design tools, the team can create visually appealing and informative presentations that help clients understand the customization options and ensure the effective communication of ideas.




CHAPTER FOUR
CHALLENGES, CONCLUSION AND RECOMMENDATION
4.1	CHALLENGES ENCOUNTERED DURING MY SIWES PROGRAMME
1. Distance from my home to my place of attachment.
2. Lack of payment from the ITF.
3. Lack of Transport Fare.
4. Traffic Congestion
5. Discrimination between Polytechnic Students and University.
4.2	CONCLUSION
I give God all the glory for his grace for making me to finish the SIWES programmed without any problem and also thanks go to the Public administartion Department of Kwara State Polytechnic, Ilorin. Also, I am not ungrateful to the contribution of 360 Print Hub. So I thank God for his wonderful knowledge and wisdom given to me.
Finally my appreciation goes to ITF office for organizing this programme.
4.3	RECOMMENDATIONS
I will suggest that the ITF should keep the SIWES program going so that students in the higher institution of learning can gain more practical experience which will prepare them ahead of the labour market demands.
I will also like to recommend EG 4sons Enterprise to student for SIWES programme. They are just not training student only on computer, but to grace the challenges out there and also their career, for them to know what Information Technology (IT) is all about. They give the right IT skill.
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